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About the EBS SQL Import Panel (DDMS)
The EBS SQL Import Control Panel, shown below, lets you validate and import your data for use with the 
SQL databases such Order Analysis, Price Plans and so on. This handout is for DDMS® only. If you are using 
DDMSPLUS®, see Using the EBS SQL Import Panel on the Customer Support Center.

The EBS SQL Import Panel allows you better control over your imports, including importing on a file level, 
scheduling imports, real-time import monitoring, and logging capabilities. This program gives you the ability 
to view database information, including SQL databases, table sizes, and record counts. When the initial import 
is made, a snapshot of the DBF files is created. Thereafter, when importing data, the new information is 
compared to the snapshot and only changes are imported. Once the update is complete, these changes are 
written to the snapshot. 

This program is installed on your DDMS Server and is easily accessible from your Windows Startup Menu. 

Note:	 If you do not use any of the SQL applications such as Price Plans, Price Modeling, Project 
Management, Order Analysis, Purchase Order Analysis, or SQL Reporting, you do not need to start 
this program. Close the EBS SQL Import Control Panel by clicking File, then Exit. 

The EBS SQL Import Control Panel automatically opens but does not automatically start. To use the program, 
you must set up the schedules and manually start the scheduler engine. Once you start using the EBS SQL 
Import program, the W-CHANGES file is no longer used. Changes are now stored in the DDMS/Sync/Volume 
Serial folder, DDMS/Sync/IN, for example. 

https://support.ecisolutions.com/doc-ddms/ddmsplus/PLUS_EBSSQLimport.pdf
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Note:	 You may need to check the size of the folder if backing up the entire folder. You may choose not to 
backup the snapshot if media size is an issue. 

When you open the EBS SQL Import Control Panel, Current Activity is displayed. You can view the name of the 
event, the next scheduled run time, last run time, and average duration of run time.

Initially, you must perform a full import of your SQL data. Thereafter, you can perform Delta imports. Delta 
imports allow you to make frequent updates of the SQL tables without impacting your system resources. 

Once you complete the initial import of your data, your DBF and SQL tables are synchronized. When you 
update your DBF files, files are automatically updated. These files are monitored and the information is 
imported into your SQL tables. As mentioned earlier, once you’ve completed the full import, the Delta import 
allows you to import only the changes. This gives you the freedom to import as frequently as you need with 
minimal impact on your system. 

ECI® recommends that you only perform the full import after large database changes such as the quarterly  
OPUS update, user-defined mass changes, or mass price plans changes. 

Before you begin using the EBS SQL Import program, make sure you meet the necessary requirements and 
have the proper software installed. The first time you use one of the EBS programs, you must complete all the 
steps in this handout. If needed, you can refer back to this document to import new files. 

The EBS SQL Import Panel allows you to perform several functions:

•	 View Current Activity

•	 Schedule Imports

•	 Validate DBF files

•	 Import Data

•	 Import Exceptions

•	 View SQL tables

•	 Stop the Scheduler Engine.

From the View menu, you can view scheduler engine logs and Import Control Panel log files.

In the Options menu, you can select to execute import schedules in parallel or sequentially. Sequential 
execution is the default. Selecting In Parallel allows you to run full or Delta imports at scheduled times even 
if other imports are already in progress. This could cause a significant affect on your system performance 
depending on the events. If you select Sequential Execution, all scheduled imports, full or Delta, do not 
execute until all other events are complete. ECI recommends Sequential Execution. You can also refresh the 
SQL Parameter tables.

Once you set up schedules, click Start Scheduler Engine to start the program. Once done, you can click Stop 
Scheduler Engine to disable schedules, if needed. Once you start running schedules, you should not close the 
EBS SQL Import Control Panel. You can click the X in the upper right corner to minimize the window. However, 
you should only close the window if you do not use any of the SQL applications such as Price Plans, Price 
Modeling, Project Management, or SQL Reporting and so on. To close the window, click File, then Exit.

A status bar displays at the bottom of the window that allows you to start or stop SQL. The SQL Status Running 
message is displayed when SQL is active. To stop SQL, click the arrow and select Stop the ECI SQL Service. 
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Note: 	 Previously, you had to set the Using Roadrunner field in the (L0)  Global Master Parameters screen 
to Y to enable the SQL data synchronization process. Now, the synchronization process is available 
whenever you are ready to start using the program. All you have to do to begin is install the latest 
DDMS Version. Contact ECI Support for the newest version, if needed. The EBS SQL Import Panel can 
only be installed on the DDMS server. 

Synchronizing SQL Data
Several applications work primarily with data in a SQL database. Before you can use the EBS programs such as 
Order Analysis or Price Plans, your system data must be initially validated, corrected as needed, and imported 
into the SQL database.

When you import, the system creates a file record of the changes. It views the information set in the text-
based (L0) screen to determine which volumes to copy. After you validate and import for the first time, the 
system synchronizes your data between the DBF files and the SQL database in the background according 
to the schedule you create. You can determine when the system synchronizes by specifying the service 
import schedule. The system defaults to import daily between the hours of 8:00 am to 5:00 pm with a four 
hour execution delay. You can change settings or delete schedules at any time. You can also set up multiple 
schedules. 

When you make changes in Price Plans and Price Modeling, the changes are written to the SQL database first. 
You can continue working as SQL changes trigger the synchronization process to write to your DBF files in the 
background.

Note:	 If you are using the EBS features and need to view your SQL database tables, you need to download 
SQL tools. 

Getting Started 
The EBS SQL Import Control Panel opens when you start your server. If you inadvertently closed the window 
and need to reopen, you can start it from the Windows Start Menu. You click Start, then All Programs. Click 
Startup, then click EBS SQL Import Control Panel.

When you open the EBS SQL Import Control Panel, Current Activity is displayed. You can view the name of the 
event, the next scheduled run time, last run time, and average duration of run time. 

If you are currently using or plan to use EBS programs, you must perform the steps in the EBS SQL Import 
Control Panel, as listed below. 

•	 Confirm Connectivity to the Server. Before using the program for the first time, you should confirm 
server connectivity. See the heading Confirming Connectivity to the Server.

•	 DBF File Validation. Validate your data then correct any errors before importing. See the heading 
Validating DBF Data. 

•	 Import Data. You must import your data from DBF to SQL. You must perform a full import. See the 
heading Importing Data to SQL.

•	 Schedule Imports. You can set up an import schedule and configure by file groups. You decide how 
frequently to update the SQL tables. See the heading Scheduling Imports. 
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•	 Start Scheduler Engine. Once you set up schedules, click Start Scheduler Engine to start the program. 
Once done, you can click Stop Scheduler Engine to disable schedules, if needed. Once you start 
running schedules, you should not close the EBS SQL Import Control Panel. You can click the X in the 
upper right corner to minimize the window. However, you should only close the window if you do not 
use any of the EBS SQL applications such as Price Plans, Price Modeling, SQL Reporting, and so on. To 
close the window, click File then Exit. For more information, see the heading Stopping the Scheduler 
Engine.  

•	 Optional functions include: Viewing the Event Log, Viewing Import Exceptions and Viewing SQL 
Metrics. See the appropriate headings.  

The following headings cover all the functions available in the EBS SQL Import Control Panel. 

Confirming Connectivity to the Server
1.	 Open Explorer.

2.	 Navigate to C:\DDMS\CLIENT\Browser or D:\DDMS\CLIENT\Browser on the Server.

3.	 Double-click EnsiteEBS.exe to open the EnsiteEBS Utility Program.

4.	 Before you import data to SQL, you need to confirm that your server is properly connected.

4.1	 Click Connectivity Test to open.

4.2	 Under Services, click Ping Ensite.DataPortal. After you click the Ping button, you should receive a 
message stating that it is connected. If you do not receive this message, contact ECI Support.

4.3	 Click Test Linked Server. You should receive a confirmation message. If you do not, contact ECI 
Support for assistance.

4.4	 When finished, click Exit.
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Validating DBF Data
Before you import DBF data to SQL, you need to make sure that the data is valid. The SQL database requires 
that data adhere to specific rules. For example, numeric fields must have valid numeric values and date fields 
must have valid dates. 

1.	 To open the EBS SQL Import Control Panel, click Start then EBS SQL Import Control Panel.

2.	 Click DBF File Validation. The Validate DBF Data window opens.

•	 To validate all files, click the first check box for All. All files are marked for validation. 

•	 To validate specific files, check the box corresponding to the files to validate. 

•	 You can also select Group by Import or select No Grouping. 

3.	 Click Process Files. As the system is validating, a Complete message appears next to the file name. 

If there are errors, the DBF Data Error Encountered message appears. Click Yes and the DBF Validation 
Exception Report opens. You can print this report or save it. If you close this report without saving, 
you cannot access it again. To correct common errors, refer to Troubleshooting DDMS SQL Validation 
Errors. If you need further assistance, contact ECI Support.

Importing Data to SQL
After you successfully validate your information, you can import data to SQL. Remember you only need to 
perform the full import the first time you import or subsequently when you make large database changes.

1.	 Click Import Data. The Import Data window opens and displays the Full Import tab. This window also 
contains the Sales Order Journal and Purchase Order Journal Import tabs. 

https://support.ecisolutions.com/doc-ddms/reports/sql/EBSvalidErrors.pdf
https://support.ecisolutions.com/doc-ddms/reports/sql/EBSvalidErrors.pdf
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2.	 Begin by importing data using the Full Import tab.

•	 To mark all files for import, click the first All check box.

•	 To import only specific files, check the box corresponding to the files to import.

Note:	 If you have not already validated your data, you must do so before importing. Click the Validate 
DBF Source Files for Selected Imports link. A window opens so you can validate the files you 
marked. You must fix any problems identified before importing. Files are validated individually but 
must be imported by file group. You must import all data files before using EBS programs such as 
Furniture Project Management, Price Plans and Price Modeling. 

3.	 Click Process. The system begins importing data and displays a green progress bar as the files are 
imported into the selected SQL Tables. 

The Avg Execution Time column displays the time spent importing each line of data. (When importing 
for the first time, a snapshot of your data is created. If you had not previously imported, that snapshot 
is created now.)

4.	 Once the program finishes, the View Import Exceptions window opens and displays any files that were 
not imported.

Note:	 The system does not import records with duplicate keys. If you have other exceptions, contact ECI 
Support for assistance.
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Importing Sales and Archived Journals
If you plan to use any of the EBS programs to analyze past sales, you must import sales journals to SQL. You 
must import data from sales journal files to the SalesOrderJournal SQL Table and the SalesOrderArchive SQL 
Table. 

The SalesOrderJournal contains your most recent sales. You must specify the number of months to 
store in this table. All sales that are older than the specified number of months can be imported to the 
SalesOrderArchive during the same procedure. After the initial import, the system automatically adds new 
completed sales to the SalesOrderJournal file. It also moves past sales that are no longer within the specified 
number of months to the SalesOrderArchive table.

1.	 In the Import Data window, click the Sales Order Journal Import tab. The tab opens, displaying the 
SalesOrderJournal option in the Import Records Into box.

2.	 Click the All check box to import all sales order journal files.  To import specific files, click the check box 
next to each file to import. 

All sales journals listed in the (LGA) screen are displayed in the File Selection box. If the file to import 
is not displayed, scroll down in the File Selection box until the Browse For Additional Journal Files link 
appears. Click this link to mark any journals not shown in the current list.

Note:	 If you have not already validated your data, you need to do so before you import. Click the 
Validate DBF Source Files for Selected Journals link. A window opens so you can validate the 
journal files you marked. 

3.	 Select the SQL table for the new records.

•	 To import the data into a table with previously imported data, click the Append New Records to 
the Existing Table Data option.
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•	 To import the data into a new table or to replace an existing table with your current import se-
lectors, click the Delete Existing Table Data and Replace with these New Records option.

4.	 In the Number of Months to Keep in Journal box, enter the number of months to keep data in the 
SalesOrderJournal. The journal keeps data up to the current date. For example, if you select 12 
months, the journal keeps data from the most recent 12 months.

ECI recommends that you accept the default of 12 months. Once you make this selection, the system 
automatically adds and removes records so that the file retains only journals for the time frame 
specified. Records older than the time frame are added to the SalesOrderArchive on a daily basis.

5.	 Click Process. The green progress bar appears as the records are processed.

6.	 When the process is complete, you can import journals to the SalesOrderArchive SQL table. Click the 
down arrow in the Import Records Into box and click the SalesOrderArchive option.

7.	 Click the first All check box to import all sales order archive files. To import specific files, click the check 
box next to each file to import. 

If the file to import is not displayed, scroll down in the File Selection box until the Browse For 
Additional Journal Files link appears. Click this link to mark any journals not shown in the current list.

Note:	 If you have not already validated your data, you need to do so before you import. Click the 
Validate DBF Source Files for Selected Journals link. A window opens so you can validate the 
journal files you marked.

8.	 Select the SQL table for the new records.

•	 To import the data into a table with previously imported data, click the Append New Records to 
the Existing Table Data option.

•	 To import the data into a new table or to replace an existing table with your current import se-
lectors, click the Delete Existing Table Data and Replace with the New Records option.

9.	 Select the Date Range by which to limit your import.

•	 To import all invoices, regardless of date, click the Import All Invoices option.

•	 To import invoices using a date range, click the Only Import Invoices with a Date Between op-
tion. Click the down arrow in the From and corresponding To boxes to select the date range 
for which to place journals in the SalesOrderArchive. You should import journal files older than 
those imported into SalesOrderJournal. Using the example in Step 4, you would import journal 
files older than 12 months.

10.	 Click Process. The green progress bar appears as the records are processed.

11.	 After your initial import, you should create a schedule for the Delta import of your sales journals.
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Importing User Defined Sales Journals
You can import specific files into the SalesOrderArchive or a user defined SQL table, for example, 
SalesOrder2021.

1.	 In the Import Data window, click the Sales Order Journal Import tab. Click the down arrow in the 
Import Records Into box and click the User Defined option. The Journal Import Table Name Entry Form 
opens. 

2.	 Enter the suffix of the journal to import and click OK. For example, you might name this 
SalesOrder2021. In this example, SalesOrder is the default and you enter the suffix of 2021 in this box.

3.	 Click the first All check box to import all files. To import specific files, click the check box next to each 
file to import. 

If the file to import is not displayed, scroll down in the File Selection box until the Browse For 
Additional Journal Files link appears. Click this link to mark any journals not shown in the current list.

Note:	 If you have not already validated your data, you need to do so before you import. Click the 
Validate DBF Source Files for Selected Journals link. A window opens so you can validate the 
journal files you marked. 

4.	 Select the SQL table for the new records.

•	 To import the data into a table with previously imported data, click the Append New Records to 
the Existing Table Data option.

•	 To import the data into a new table or to replace an existing table with your current import se-
lectors, click the Delete Existing Table Data and Replace with these New Records option.
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5.	 Select the Date Range by which to limit your import.

•	 To import all invoices, regardless of date, click the Import All Invoices option.

•	 To import using a date range, click the Only Import Invoices with a Date Between option. Click 
the down arrow in the From and corresponding To boxes to select the date range to import.

6.	 Click Process. The green progress bar appears as the records are processed.

Deleting User Defined Sales Journals
You can delete user defined table groups. 

1.	 In the Import Data window, click the Sales Order Journal Import tab. 

2.	 Click the down arrow in the Import Records Into box and select the user defined sales order table. 

3.	 Click Delete This Table Group (to the right of the Import Records Into box). The Delete Table Group 
dialog box opens. 

•	 Click Yes to delete the selected table group.

•	 Click No to not delete the selected table group.

Importing Purchase Order Journals
You must import purchase order journals to SQL if you plan to use the application to analyze past purchase 
orders. You can use the Purchase Order Journal Import tab to import data from purchase order journal files 
to the PurchaseOrderJournal SQL Table and the PurchaseOrderArchive SQL Table. The PurchaseOrderJournal 
contains your most recent purchase orders. You must specify the number of months to store in this 
table. All purchase orders that are older than the specified number of months can be imported to the 
PurchaseOrderArchive during the same procedure. After the initial import, the system automatically adds 
newly completed purchase orders to the PurchaseOrderJournal file. It also moves previous purchase orders 
that are no longer within the specified number of months to the PurchaseOrderArchive table.

1.	 In the Import Data window, click the Purchase Order Journal Import tab. The Import Records Into box 
defaults to PurchaseOrder Journal.

2.	 Click the first All check box to import all P/O journal files. To import specific files, click the check box 
next to each file to import. All purchase order journals listed in the (LF2) screen are displayed here. 

If the file to import is not displayed, scroll down in the File Selection box until the Browse For 
Additional Journal Files link appears. Click this link to mark any journals not shown in the (LF2) screen.

Note:	 If you have not already validated your data, you need to do so before you import. Click the 
Validate DBF Source Files for Selected Journals link. A window opens so you can validate the 
journal files you marked. 

3.	 Select the SQL table for the new records.

•	 To import the data into a table with previously imported data, click the Append New Records to 
the Existing Table Data option.

•	 To import the data into a new table or to replace an existing table with your current import se-
lectors, click the Delete Existing Table Data and Replace with these New Records option.
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4.	 In the Number of Months to Keep in Journal box, enter the number of months to keep data in the 
PurchaseOrderJournal. The journal keeps data up to the current date. For example, if you select 12 
months, the journal keeps data from the most recent 12 months. ECI recommends that you accept 
the default of 12 months. Once you make this selection, the system automatically adds and removes 
records so that the file retains only journals for the time frame specified. Records older than the time 
frame are added to the PurchaseOrderArchive on a daily basis.

5.	 Click Process. The green progress bar appears as the records are processed.

6.	 When the process is complete, you can import journals to the PurchaseOrderArchive SQL table. Click 
the down arrow in the Import Records Into box and click the PurchaseOrderArchive option. 

7.	 Click the first All check box to import all sales archive files. To import specific files, click the check box 
next to each file to import. 

If the file to import is not displayed, scroll down in the File Selection box until the Browse For 
Additional Journal Files link appears. Click this link to mark any journals not shown in the (LF2) screen.

Note:	 If you have not already validated your data, you need to do so before you import. Click the 
Validate DBF Source Files for Selected Journals link. A window opens so you can validate the 
journal files you marked.

8.	 Select the SQL table for the new records.

•	 To import the data into a table with previously imported data, click the Append New Records to 
the Existing Table Data option.

•	 To import the data into a new table or to replace an existing table with your current import se-
lectors, click the Delete Existing Table Data and Replace with these New Records option.

9.	 Select the Date Range by which to limit your import.

•	 To import all purchase orders, regardless of date, click the Import All Invoices option.

•	 To import purchase orders using a date range, click the Only Import Invoices with a Date Be-
tween option. Click the down arrow in the From and corresponding To boxes to select the date 
range for which to place journals in the JournalOrderArchive. You should import journal files 
older than those imported into PurchaseOrderJournal. Using the example in Step 4, you would 
import journal files older than 12 months.

10.	 Click Process. The green progress bar appears as the records are processed.

Importing User Defined Purchase Order Journals
You can import specific files into the PurchaseOrderArchive or a user defined SQL table, for example, 
PurchaseOrder2021.

1.	 In the Import Data window, click the Purchase Order Journal Import tab. Click the down arrow in the 
Import Records Into box and click the User Defined option.

2.	 When the Journal Import Table Name Entry Form opens, enter the suffix of the journal to import and 
click OK. For example, you might name this PurchaseOrder2021. In this example, PurchaseOrder is the 
default and you enter the suffix of 2021 in this box.

3.	 Click the first All check box to import all files. To import specific files, click the check box next to each 
file to import. 
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If the file to import is not displayed, scroll down in the File Selection box until the Browse For 
Additional Journal Files link appears. Click this link to mark any journals not shown in the current list.

Note:	 If you have not already validated your data, you need to do so before you import. Click the 
Validate DBF Source Files for Selected Journals link. A window opens so you can validate the 
journal files you marked. 

4.	 Select the SQL table for the new records.

•	 To import the data into a table with previously imported data, click the Append New Records to 
the Existing Table Data option.

•	 To import the data into a new table or to replace an existing table with your current import se-
lectors, click the Delete Existing Table Data and Replace with these New Records option.

5.	 Select the Date Range by which to limit your import.

•	 To import all invoices, regardless of date, click the Import All Invoices option.

•	 To import using a date range, click the Only Import Invoices with a Date Between option. Click 
the down arrow in the From and corresponding To boxes to select the date range to import.

6.	 Click Process. The green progress bar appears as the records are processed.

7.	 Select the date range by which to limit your import. The system defaults to 12 months before the dates 
you selected for the PurchaseOrderJournal import.

Note:	 If you have not already validated your data, you need to do so before you import. Click Validate 
Source DBF Data.

8.	 Click Process.

Deleting User Defined Purchase Order Journals
You can delete user defined table groups.

1.	 In the Import Data window, click the Purchase Order Journal Import tab.

2.	 Click the down arrow in the Import Records Into box and select the user defined purchase order table.

3.	 Click Delete This Table Group (to the right of the Import Records Into box).The Delete Table Group 
dialog box opens. 

•	 Click Yes to delete the selected table group. 

•	 Click No to not delete the selected table group.

Importing Accounts Receivable Journals
You must import accounts receivable journals to SQL if you plan to use the application to analyze past 
accounts receivable. You can use the Accounts Receivable Journal Import tab to import data from accounts 
receivable journal files to the AccountsReceivableJournal SQL Table, the AccountsReceivableArchive SQL 
Table, and the AccountsReceivableDeposit SQL Table.  The AccountsReceivableJournal contains your 
most recent orders. You must specify the number of months to store in this table. All orders that are 
older than the specified number of months can be imported to the AccountsReceivableArchive during 
the same procedure. After the initial import, the system automatically adds newly completed A/R to the 
AccountsReceivableJournal file. It also moves previous A/R that is no longer within the specified number of 
months to the AccountsReceivableArchive table. 
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1.	 In the Import Data window, click the Accounts Receivable Journal Import tab. The Import Records Into 
box defaults to AccountsReceivableJournal. 

2.	 Click the first All check box to import all A/R journal files. To import specific files, click the check box 
next to each file to import. All accounts receivable journals listed in the (LA4) screen display.  

If the file to import is not displayed, scroll down in the File Selection box until the Browse For 
Additional Journal Files link appears. Click this link to mark any journals not shown in the (LA4) screen.

Note:	 If you have not already validated your data, you need to do so before you import. Click the 
Validate DBF Source Files for Selected Journals link. A window opens so you can validate the 
journal files you marked.

3.	 Select the SQL table for the new records.

•	 To import the data into a table with previously imported data, click the Append New Records to 
the Existing Table Data option.

•	 To import the data into a new table or to replace an existing table with your current import se-
lectors, click the Delete Existing Table Data and Replace with these New Records option.

4.	 In the Number of Months to Keep in Journal box, enter the number of months to keep data in the 
AccountsReceivableJournal. The journal keeps data up to the current date. For example, if you select 
12 months, the journal keeps data from the most recent 12 months. ECI recommends that you accept 
the default of 12 months. Once you make this selection, the system automatically adds and removes 
records so that the file retains only journals for the time frame specified. Records older than the time 
frame are added to the AccountsReceivableArchive on a daily basis.

5.	 Click Process. The green progress bar appears as the records are processed. When the process is 
complete, you can import journals to the AccountsReceivableArchive SQL table. 

6.	 Click the down arrow in the Import Records Into box and click the AccountsReceivableArchive option.

7.	 Click the first All check box to import all sales archive files. To import specific files, click the check box 
next to each file to import. 

If the file to import is not displayed, scroll down in the File Selection box until the Browse For 
Additional Journal Files link appears. Click this link to mark any journals not shown in the (LA4) screen.

Note:	 If you have not already validated your data, you need to do so before you import. Click the 
Validate DBF Source Files for Selected Journals link. A window opens so you can validate the 
journal files you marked.

8.	 Select the SQL table for the new records.

•	 To import the data into a table with previously imported data, click the Append New Records to 
the Existing Table Data option.

•	 To import the data into a new table or to replace an existing table with your current import se-
lectors, click the Delete Existing Table Data and Replace with these New Records option.
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9.	 Select the Date Range by which to limit your import.

•	 To import all invoices, regardless of date, click the Import All Invoices option.

•	 To import invoices using a date range, click the Only Import Invoices with a Date Between op-
tion. Click the down arrow in the From and corresponding To boxes to select the date range for 
which to place journals in the JournalOrderArchive. You should import journal files older than 
those imported into AccountsReceivableJournal. Using the example in Step 4, you would import 
journal files older than 12 months.

10.	 Click Process. The green progress bar appears as the records are processed. When the process is 
complete, you can import journals to the AccountsReceivableDeposit SQL table. 

11.	 Click the down arrow in the Import Records Into box and click the AccountsReceivableDeposit option. 

12.	 Click the first All check box to import all A/R deposit files. To import specific files, click the check box 
next to each file to import. 

If the file to import is not displayed, scroll down in the File Selection box until the Browse For 
Additional Journal Files link appears. Click this link to mark any journals not shown in the (LA4) screen.

Note:	 If you have not already validated your data, you need to do so before you import. Click the 
Validate DBF Source Files for Selected Journals link. A window opens so you can validate the 
journal files you marked. 

13.	 Select the SQL table for the new records.

•	 To import the data into a table with previously imported data, click the Append New Records to 
the Existing Table Data option.

•	 To import the data into a new table or to replace an existing table with your current import se-
lectors, click the Delete Existing Table Data and Replace with these New Records option.

14.	 Select the Date Range by which to limit your import.

•	 To import all invoices, regardless of date, click the Import All Invoices option.

•	 To import invoices using a date range, click the Only Import Invoices with a Date Between op-
tion. Click the down arrow in the From and corresponding To boxes to select the date range for 
which to place journals in the JournalOrderArchive. You should import journal files older than 
those imported into AccountsReceivableJournal. Using the example in Step 4, you would import 
journal files older than 12 months.

15.	 Click Process. The green progress bar appears as the records are processed.

Importing User Defined Accounts Receivable Journals
You can import specific files into the AccountsReceivableArchive or a user defined SQL table, for example, 
AccountsReceivable2021.

1.	 In the Import Data window, click the Accounts Receivable Journal Import tab. 

2.	 Click the down arrow in the Import Records Into box, and select the User Defined option.

3.	 When the Journal Import Table Name Entry Form opens, enter the suffix of the journal to import 
and click OK. For example, you might name this AccountsReceivable2021. In this example, 
AccountsReceivable is the default and you enter the suffix of 2021 in this box.
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4.	 Click the first All check box to import all A/R journal files. To import specific files, click the check box next 
to each file to import. All accounts receivable journals listed in the (LA4) screen are displayed.

If the file to import is not displayed, scroll down in the File Selection box until the Browse For 
Additional Journal Files link appears. Click this link to mark any journals not shown in the (LA4) screen.

Note:	 If you have not already validated your data, you need to do so before you import. Click the 
Validate DBF Source Files for Selected Journals link. A window opens so you can validate the 
journal files you marked.

5.	 Select the SQL table for the new records.

•	 To import the data into a table with previously imported data, click the Append New Records to 
the Existing Table Data option.

•	 To import the data into a new table or to replace an existing table with your current import se-
lectors, click the Delete Existing Table Data and Replace with these New Records option.

6.	 In the Number of Months to Keep in Journal box, enter the number of months to keep data in the 
AccountsReceivableJournal. The journal keeps data up to the current date. 

For example, if you select 12 months, the journal keeps data from the most recent 12 months. ECI 
recommends that you accept the default of 12 months. Once you make this selection, the system 
automatically adds and removes records so that the file retains only journals for the time frame 
specified. Records older than the time frame are added to the AccountsReceivableArchive on a daily 
basis.

7.	 Click Process.

Deleting User Defined Accounts Receivable Journals
You can delete user defined table groups. 

1.	 In the Import Data window, click the Accounts Receivable Journal Import tab.

2.	 Click the down arrow in the Import Records Into box and select the user defined accounts receivable 
table.

3.	 Click Delete This Table Group (to the right of the Import Records Into box).

4.	 The Delete Table Group dialog box opens. Click Yes to delete the selected table group. Click No to not 
delete the selected table group. 

Scheduling Imports
Scheduling imports varies from dealer to dealer. This window lets you validate and import your data for use 
with the SQL databases, such as Furniture Project Management, Price Plans, Price Modeling, SQL Reporting 
and so on. Before scheduling imports, you should review your business processes so that you can make 
informed decisions about when and how to schedule imports. For example, consider how often you make 
database changes. Then you can decide how often to schedule a customer or vendor import. 

You must initially do a full import. After you’ve imported data for the first time, you can schedule Delta 
imports. Delta imports allow you to make frequent updates of the SQL tables without impacting your system 
resources. However, ECI recommends that you run a full import daily for sales order detail, purchase order 
detail, and accounts receivable. Full imports should be run weekly for databases: customers, items, vendors, 
and so on.
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Using the Schedule Imports feature, you can specify that the system update your databases according to a set 
time and day. The system defaults to import daily between the hours of 8:00 am to 5:00 pm. You can add a 
new schedule, edit an existing one, or delete an existing schedule.

1.	 Click the Schedule Imports button. 

2.	 To add a new schedule, edit an existing schedule, or delete a schedule, right-click the schedule to 
change and select the appropriate option. If you select Delete Schedule, the schedule is immediately 
deleted with no warning. To add or edit a schedule, continue to Step 3. 

3.	 The Import Schedule Setup dialog box opens. You can change the Schedule Properties, Frequency, 
Daily Frequency, and Duration settings.

3.1	 In the Schedule Type box, use the drop-down arrow to select One Time or Recurring. If you 
selected Recurring, go to Step 3.3.

3.2	 If you selected On Time, set the date and time for the event. Click the drop down arrow in the 
Date box to select the date to run the event. Use the drop-down arrow in the Time box to select 
the time to run this event. Go to Step 4.

3.3	 If you selected Recurring, you must set the frequency for this event. In the Occurs box, use the 
drop-down arrow to select daily, weekly, or monthly. 
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3.4	 The Recurs Every box changes, depending on what you selected in the Occurs box. For example, 
if you selected Daily, use the drop down arrows to select how many days to run the event. 

•	 If you selected Weekly, you can select which weeks to run the event as well as the day of 
the week on which to run the event. For example, you might select to run the event every 
two weeks on Friday. In this case, select 2 in the Recurs Every box and click Friday.

•	 If you selected Monthly, you select which day of which month to run the event. 

3.5	 Next, you set up Daily Frequency. You can choose to have the event occur once daily at a specific 
time by clicking Occurs Once At. Then select the time using the drop down arrows.

You can select Occurs Between. Select the beginning time in the first time boxes and the ending 
time in the second set of boxes. Then you can set the execution delay time by entering either a 
number of minutes or a number of hours. 
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3.6	 Set up the event Duration. Use the drop down arrow to set the Start Date. Then either select 
the End Date or No End Date. 

3.7	 When finished, click OK. To not create or edit a schedule, click Cancel. 

Note:	 Remember when setting up schedules that you can select to execute import schedules 
parallel or sequentially from the Options menu. Sequential execution is the default and the 
recommended method to use. For more information on the Options menu, refer back to the 
heading About the EBS SQL Import Program.

4.	 Once you set up schedules, you must click Start Scheduler Engine to start the program. Once done, 
you can click Stop Scheduler Engine to disable schedules, if needed. Once you start running schedules, 
you should not close the EBS SQL Import Control Panel. You can click the X in the upper right corner to 
minimize the window.

Note:	 A status bar displays at the bottom of the window that allows you to start or stop SQL. The SQL 
Status Running message is displayed when SQL is active. To stop SQL, click the arrow and select 
Stop the ECI SQL Service.   

Viewing Import Exceptions
ECI recommends that you periodically check for exceptions that may occur during scheduled imports. 

1.	 During the import process, you can click the Import Exceptions button to view a list of exceptions that 
can occur. Exceptions and their corresponding descriptions appear in columns. 

2.	 Click + (plus sign) to expand the information.

Note:	 To correct common errors, refer to Troubleshooting DDMS SQL Validation Errors. If you need 
further assistance, contact ECI Support.

3.	 To update the page, click Refresh Grid.

https://support.ecisolutions.com/doc-ddms/reports/sql/ebsvalidErrors.pdf
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Viewing the Event Log
You can use the event log to view previous events in the EBS SQL Import Control Panel.

1.	 Click the View menu and click Import Control Panel Log File.

2.	 Scroll through the event log to locate the event to view. 

Note:	 You can view the event log and run the connectivity test on both the client and the server.
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Viewing SQL Metrics
You can view database and table sizes and table record counts. You can see your database size and keep track 
of your disk capacity with ease. You can also compact the database, if needed. 

1.	 Click SQL Metrics to view information.

2.	 Click + (plus sign) to the left of each table to view corresponding Row Counts and Size. For example, to 
view accounts payable metrics, click + to the left of AccountsPayableDeposit column. 

3.	 You can compact your database. Click Compact Database and the This Will Compact the Ensite 
Database and Truncate All Logs message appears. To continue, click Yes. 

4.	 To update the page, click Refresh Grid.

Stopping the Scheduler Engine
Some functions, such as Day-End procedures, require you to stop the scheduler engine.

1.	 To open the EBS SQL Import Control Panel, click Start then EBS SQL Import Control Panel.

2.	 Click Current Activity.

3.	 Click Stop Scheduler Engine.

4.	 To start the scheduler engine again, click Start Scheduler Engine.


